Создаём новогоднюю открытку в Фотошоп

В этом уроке я дам Вам несколько советов, как создать красочный фон с Новогодней елкой и глянцевыми шарами Adobe Photoshop CS6. Вы узнаете, как добавить Стили слоя (Layer Style), рисовать рождественские украшения с помощью инструмента Эллипс (Ellipse Tool), применять Кисти (Brush), использовать пользовательские формы и т.д.





Начнем, создадим новый документ (Ctrl + N) в Adobe Photoshop, размером 1000px на 1000px (RGB цветовом режиме) при разрешении 72. Используйте инструмент Заливка [image: image1.png]


(Paint Bucket Tool) (G), чтобы заполнить новый фоновый слой цветом # FEE686.
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Далее нам понадобится текстурированный узор, Вы можете скачать его здесь, если Вы хотите, можете заменить его на аналогичный собственный узор. Откройте его в Adobe Photoshop и перейдите Редактирование-> Определить узор (Edit-> Define Pattern). Введите имя шаблона в диалоговом окне.
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Далее создадим новый слой (Ctrl + Shift + N) и установим Заливка (Fill) на 0% для этого слоя. Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Наложение узора (Overlay Pattern). Нажмите на Узор (Pattern) и найдите свой шаблон, созданный ранее в списке шаблонов.
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Мы получили следующий результат.
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Создайте новый слой (Ctrl + Shift + N) и выберите мягкую круглую Кисть [image: image6.png]


(Brush) белого цвета (установите Непрозрачность (Opacity) до 40% в панели параметров).
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Используйте эту кисть, чтобы нарисовать белое пятно на фоне.
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Выберите инструмент Перо [image: image9.jpg]


(Pen Tool) (P), установите режим рисования Фигура (Shape Layers) в панели настроек и попробуйте нарисовать следующую фигуру (элемент) это будет елка.
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Мы получили следующий результат.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Наложение градиента (Gradient Overlay).
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.
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Сделайте три копии (Ctrl + J) сделанного элемента и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы сделать их меньше, перебирая по одной, и получить елку, как на картинке ниже.
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На нижнем элементе елки, мы будем рисовать блик, выберите инструмент Перо [image: image16.jpg]


(Pen Tool) (P), установите режим рисования Фигура (Shape Layers) в панели параметров и нарисуйте следующую форму, как показано на рисунке. Слой должен быть расположен под следующим элементом дерева.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Наложение градиента (Gradient Overlay).
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.
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Далее сделайте три копии (Ctrl + J) этого элемента и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы уменьшить каждый следующий экземпляр, и расставить их таким же образом, как на картинке ниже. Слои копии должны быть помещены в правильной последовательности между элементами елки.
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Создайте новый слой (Ctrl + Shift + N) и нарисуйте на нем пятно, используя мягкую круглую Кисть (Brush), это будет тень.
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Кисть [image: image23.png]


(Brush) цвета # 012F00.
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Используя команду Свободное трансформирование (Free Transform) (Ctrl + T), растянем  и сожмем пятно, как это показано на следующем изображении. Слой должен быть расположен под слоем, содержащим самый первый элемент елки.
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Мы получили следующий результат.
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Создайте новый слой (Ctrl + Shift + N) и поместите его над первым элементом елки. Убедитесь, что слой является активным, а затем зажмите клавишу Ctrl и нажмите на слой, содержащий первый элемент елки, чтобы сделать следующее выделение.
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Выберите мягкую круглую Кисть [image: image28.png]


(Brush) черного цвета (установите Непрозрачность (Opacity) до 30% в панели параметров).
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Используйте эту кисть для рисования внутри выделения, это будет тень.
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Таким образом, мы будем рисовать тень для других элементов, составляющих елку.
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Теперь мы должны нарисовать небольшой круг белого цвета, используя инструмент Эллипс [image: image32.png]


(Ellipse Tool)(U). Поместите слой под слоями елки.
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Установим Заливка (Fill) до 40% для слоя, содержащего круг.
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Сделайте две копии слоя (Ctrl + J), содержащего круг. Используя команду Свободное трансформирование (Free Transform) (Ctrl + T) изменим размеры копий, чтобы получить тот же результат, как на следующей картинке. Слои копии должны быть расположены под элементами елки.
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Создайте новый слой, и выберите мягкую круглую Кисть [image: image36.png]


(Brush).
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Используйте эту Кисть [image: image38.png]


(Brush), чтобы нарисовать основные элементы свечения на елке. Цвет кисти  # FFEA70 (Непрозрачность (Opacity) кисти - 50%). Этот слой будет расположен над элементами елки.
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Установим Заливка (Fill) до 78% для этого слоя и изменим Режим смешивания (Blend Mode) на Жесткое смешение (Hard Mix).
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Нажмите на иконку Создать новый корректирующий слой или слой заливку (Create new fill or adjustment layer) в нижней части палитры слоев, и выберите Кривые (Curves) для регулировки формы кривой, как показано, чтобы сделать некоторые корректировки цвета.
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Мы получили следующий результат.
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Выберите инструмент Произвольная фигура [image: image43.png]


(Custom Shape Tool) (U) в панели инструментов, и в панели параметров нажмите на иконку Фигура (Shape), чтобы открыть меню выбора. Найдем 5-конечная звезда (5 Point Star) в нижней части меню, а затем дважды щелкните на миниатюру фигуры, чтобы выбрать ее.
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Нажмите и перетащите, чтобы нарисовать фигуру, как показано на рисунке ниже.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Обводка (Stroke):
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Добавим Наложение градиента (Gradient Overlay):
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.
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Теперь мы должны сделать следующий элемент звезды. Выберите инструмент Перо [image: image50.jpg]


(Pen Tool) (P), установите режим рисования Фигура (Shape Layers) в панели параметров и нарисуйте следующую форму, как показано на рисунке.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Наложение градиента (Gradient Overlay):
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.
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Сделайте четыре копии последнего слоя (Ctrl + J) и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы изменить размеры копии, размещая их таким же образом, показано на следующей картинке. Измените направление градиента в параметрах Наложение градиента (Gradient Overlay): чтобы получить такой же эффект, как на картинке ниже.
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Мы получили следующий результат.
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Объединим в группу все слои звезды (зажмите CTRL, чтобы выделить необходимые слои и удерживайте левую кнопку мыши при перетаскивании выбранных слоев на иконку Создать новую группу (Create a new group) в нижней части панели слоев).

Сделайте копию новой группы (Ctrl + J) и растрируйте ее (выберите группу, в панели слоев и нажмите CTRL + E, чтобы Объединить слои (Merge Down)).

Используя команду Свободное трансформирование (Free Transform) (Ctrl + T), сделаем меньше растрированный слой, содержащий звезды и расположим его таким же образом, как показано ниже.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Внешнее свечение (Outer Glow):
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Мы получили следующий результат.
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Далее мы будем рисовать рождественские шары, чтобы украсить нашу елку, используя инструмент Эллипс [image: image60.png]


(Ellipse Tool) (U) рисуем следующий круг.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Внутренняя тень (Inner Shadow):
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Добавим Наложение градиента (Gradient Overlay):
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).

[image: image64.jpg]Name: | Custom

[ Grdent Type:| Solid v

‘smoothness: 100 | + | %
] ]

|

929292 FFFFFFC]
Stops

Opacity Location: Delete

color, Location: Delete





Мы получили следующий результат.
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Сделайте копию последнего сделанного слоя шара и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы увеличить копию и поместить слой под слоем с первым шаром. Добавьте на слое копии, другие настройки Наложение градиента (Gradient Overlay):
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.

[image: image68.jpg]



Создайте новый слой (Ctrl + Shift + N) и выберите мягкую круглую Кисть[image: image69.png]


 (Brush).
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Используйте эту кисть, чтобы нарисовать тени (так же, как мы это делали с тенью самого первого элемента на елке). Слой тени должны быть расположены под слоем шара. Кисть цвета # 053403.
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Сделайте копию недавно сделанного слоя с тенью (Ctrl + J) и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы поместить копию именно так, как показано на картинке ниже. Слой копии должны быть помещены под слоем, содержащим красный шар.
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Создайте новый слой (Ctrl + Shift + N) и выберите мягкую круглую Кисть [image: image73.png]


(Brush), чтобы закрасить на елке следующей зоны, как показано. Цвет кисти # FFE870 (Непрозрачность (Opacity) - 10%). Чтобы сделать отражение на красном шаре, мы зажимаем клавишу CTRL и кликаем на слое с шаром, чтобы создать выделение, используйте мягкую круглую Кисть (Brush), закрасим внутри выделение, как показано на картинке ниже.
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Далее мы должны сделать поддержку для украшения. На этот раз активируем инструмент Прямоугольник [image: image75.jpg]


(Rectangle Tool) (U) и нарисуем прямоугольник. Слой с этим элементом должен быть расположен под слоем с шаром.
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Нажмите на иконку Добавить стиль слоя (Add a layer style) в нижней части панели слоев и выберите Наложение градиента (Gradient Overlay):
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Щелкните на цветовой панели, чтобы открыть Редактор градиентов (Gradient Editor) и установите цвета, как показано на рисунке ниже. Нажмите OK, чтобы закрыть диалоговое окно Редактор градиентов (Gradient Editor).
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Мы получили следующий результат.
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Сделайте копию слоя с держателем (Ctrl + J) и выберите команду Свободное трансформирование (Free Transform) (Ctrl + T), чтобы наклонить слой копию и разместить, как на картинке. Слой копии должен быть расположен выше слоя, содержащего красный шар.
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Мы получили следующий результат.
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Создайте новый слой (Ctrl + Shift + N) и выберите мягкую круглую Кисть (Brush).
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Используйте эту кисть, чтобы нарисовать тень под звездой расположенной на верхушке елки. Цвет кисти серый (Непрозрачность (Opacity) кисти - 20%). Поместите слой с тенью под слоями звезды.
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Далее мы скачаем набор пользовательских форм декоративных снежинок. Посмотреть, как загрузить пользовательские формы, Вы можете здесь.
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Создайте новый файл Файл-> Новый (File-> New) размером 1280px на 720px (RGB цветовом режиме) при разрешении 72.

Выберите инструмент Произвольная фигура [image: image85.png]


(Custom Shape Tool) (U) в панели инструментов, в панели параметров нажмите на кнопку Фигура (Shape), чтобы открыть меню выбора.

Найдем загруженные Декоративные формы снежинок в нижней части меню, а затем дважды щелкните на миниатюру формы, чтобы выбрать ее. Нажмите и перетащите, чтобы нарисовать несколько фигур, как показано на рисунке. Фигуры имеют белый цвет (без фона, здесь показан фон только для восприятия текстур). Объедините в группу все слои снежинок (зажмите CTRL, чтобы выделить необходимые слои и удерживайте левую кнопку мыши при перетаскивании выбранных слоев на иконку Создать новую группу (Create a new group) в нижней части панели слоев).
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Создайте новый слой (Ctrl + Shift + N) и, используя другую форму снежинки из инструмента Произвольная фигура [image: image87.png]


(Custom Shape Tool) (U) нарисуйте следующий шаблон, как показано используя черный цвет. Объедините в группу все слои снежинок.
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Теперь мы должны растрировать каждую из групп (выберите группу и нажмите (CTRL + E), чтобы Объединить слои (Merge Down)). Выберите слой с черными снежинками и наложите текстуру на 3D-поверхность, для этого перейдем 3D-> Новая сетка из слоя-> Набор сетки-> Сфера (3D-> New Mesh from Layer-> Mesh Preset-> Sphere).
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Далее мы будем перемещать 3D-слой сферы в нашем основном документе. Поместите слой 3D-сферы над серым шаром в панели слоев.

[image: image90.jpg]



Установите Режим смешивания (Blend Mode) этого слоя на Перекрытие (Overlay).

[image: image91.jpg]



Такая же процедура должна быть выполнена с белой текстурой.
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Установите Режим смешивания (Blend Mode) этого слоя на Жесткое смешение (Hard Mix).
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На последнем этапе мы будем рисовать небольшую нить для маленькой звезды, используя инструмент Линия (Line Tool) (U) (установите  1 пиксель в панели параметров). Цвет # FFF8A8.
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Установим Заливка (Fill) до 40% для этого слоя.
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Затем, мы будем рисовать тень, используя тот же инструмент черного цвета. Слой тени будет расположен под слоем с нитью.
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Установим Заливка (Fill) до 40% для этого слоя.
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Мы получили следующий результат.




Наш красочный фон готов. Надеюсь, Вам понравился этот урок.
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